Contents

Getting Started ................................................................................................................................. 4
  Document Scope and Audience ........................................................................................................ 4
  Documentation Roadmap .................................................................................................................. 4
  What is ALBPM Enterprise?............................................................................................................ 4
  What's New in ALBPM 6.0 Enterprise .............................................................................................. 5

WLS Single-Node Configuration .......................................................................................................... 7
  Configuration Roadmap ................................................................................................................... 7
  Running the ALBPM Configuration Wizard (Single Node) ............................................................... 7
  Deploying a Project ......................................................................................................................... 8

WLS Basic Cluster Configuration ....................................................................................................... 10
  Configuration Roadmap ................................................................................................................. 10
  Creating a New Domain .................................................................................................................. 10
  Running the ALBPM Configuration Wizard (Cluster) ................................................................. 10
  Targeting Deployments to a Cluster ............................................................................................... 11
  Deploying a Project ....................................................................................................................... 12

Integrating with AquaLogic Interaction ............................................................................................ 13
  Configuration Prerequisites ........................................................................................................... 13
  Running the WorkSpace Extension Configuration Wizard .......................................................... 13
  Configuring the ALI Identity Service Database ......................................................................... 14
  Configuring the AquaLogic Identity Service .............................................................................. 15
  Deploying the .pte File .................................................................................................................. 15
  Assigning Process Administrators ............................................................................................... 15
  Restart ALI Services .................................................................................................................... 16
  Running the Configuration Wizard ............................................................................................. 16
  Verifying Your Installation ............................................................................................................ 17

WebLogic Portal Configuration ........................................................................................................... 19
  Configuration Roadmap ................................................................................................................. 19
  Configuration Prerequisites ........................................................................................................... 19
  Configuring Domains .................................................................................................................... 20
    Configuring a Single Domain ........................................................................................................ 20
  Running the ALBPM Configuration Wizard ............................................................................... 21
  Configure Single Sign On (SSO) .................................................................................................. 22
  Creating the ALBPM Application Files ....................................................................................... 22
  Deploying the WAR File in WebLogic Portal .............................................................................. 22
  Updating the Portal Web Project .................................................................................................. 23
  Disabling JSP Validation ............................................................................................................... 24
  Refreshing the Web Project .......................................................................................................... 24
  Creating ALBPM Portlets ............................................................................................................. 25
  Creating Login Portlet .................................................................................................................. 26
  Verifying your Installation ............................................................................................................ 27
Getting Started

This document provides information on configuring AquaLogic BPM Enterprise and the Process Execution Engine. It assumes that you have followed the procedures for installing the ALBPM Enterprise in the ALBPM Installation Guide. Depending on which component you are configuring, there may be additional prerequisites which you must perform. See specific sections for more information.

Enterprise Standalone Edition

This document provides information that is specific to the AquaLogic BPM Enterprise Standalone edition.

Enterprise for WebLogic Edition

This document provides information that is specific to AquaLogic BPM Enterprise for WebLogic Server edition.

Enterprise for WebSphere Edition

This document provides information that is specific to AquaLogic BPM Enterprise for WebSphere Application Server edition.

Document Scope and Audience

This document is a resource for system administrators who need to configure BEA's AquaLogic BPM Enterprise using IBM's WebSphere Application Server. It also provides information on integrating ALBPM Enterprise with other BEA products.

This document assumes that you have already performed a basic installation of ALBPM Enterprise.

Documentation Roadmap

The AquaLogic BPM Documentation Set provides comprehensive information for installing, configuring, and using each component of the ALBPM Product Suite.

The current version of the AquaLogic BPM documentation set is available at http://edocs.bea.com.

What is ALBPM Enterprise?

AquaLogic BPM Enterprise is the runtime environment for executing business processes implemented through an iterative methodology in AquaLogic BPM Studio. The ALBPM Enterprise package is composed of a set of different applications.

These applications are listed in the following table:

<table>
<thead>
<tr>
<th>Application</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Admin Center</td>
<td>Administrative tool to setup an ALBPM Enterprise environment.</td>
</tr>
<tr>
<td>Process Execution Engine</td>
<td>Engine that executes business processes.</td>
</tr>
</tbody>
</table>
### ALBPM Enterprise Editions

AquaLogic BPM Enterprise is available in the following editions:

<table>
<thead>
<tr>
<th>Edition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standalone</td>
<td>Allows you to run the Process Execution Engine as a standalone Java application, outside of any application server. This edition uses an application server only for the web-based user interfaces (a version of Tomcat is included with the installation).</td>
</tr>
<tr>
<td>BEA WebLogic Server</td>
<td>Allows you to run the Process Execution Engine on top of BEA WebLogic Server. With this configuration you can take advantage of the J2EE container capabilities like transaction management, clustering and centralized administration.</td>
</tr>
<tr>
<td>IBM WebSphere Application Server</td>
<td>Allows you to run the Process Execution Engine on top of IBM WebSphere Application Server. With this configuration you can take advantage of the J2EE container capabilities like transaction management, clustering and centralized administration.</td>
</tr>
</tbody>
</table>

### WorkSpace Extensions

In addition to the standard WorkSpace application, ALBPM provides a set of WorkSpace Extensions. Each WorkSpace Extension provides an alternative mechanism for presenting WorkSpace functionality to end users.

ALBPM provides the following WS Extensions:

<table>
<thead>
<tr>
<th>WorkSpace Extension</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WorkSpace Extensions for Java Server Faces</td>
<td>Provides a standard web application deployable on any JSF-compliant container like BEA WebLogic Portal. See WebLogic Portal Configuration on page 19 for more information.</td>
</tr>
<tr>
<td>WorkSpace Extensions for AquaLogic User Interaction</td>
<td>Provides integration with AquaLogic User Interaction. See Integrating with AquaLogic Interaction on page 13 for more information.</td>
</tr>
<tr>
<td>WorkSpace Extensions for Rich Site Summary (RSS)</td>
<td>Provides a standard web application that serves RSS feeds. This allows end users to receive inbox notifications within an RSS client.</td>
</tr>
</tbody>
</table>

### What's New in ALBPM 6.0 Enterprise

This section provides an overview of the main new features, improvements and changes in this release of AquaLogic BPM Enterprise (all editions).

**New features**

- There is a new Configuration Wizard which provides a simple way for configuring a complete ALBPM Enterprise installation. It covers the most common configuration tasks, including: creation of Directory Service database, creation of Engine definition and database, complete creation of WebLogic domain, and deployment of a sample project.
• ALBPM Directory Service can be configured in a Hybrid configuration where authentication and authorization can be delegated to Microsoft Active Directory or Sun One Directory Service while the rest of the metadata resides in a transactional RDBMS. This avoids the need for replication of participants and entitlements data.
• ALBPM now includes JDBC drivers for the most popular DBMS. This means you can integrate with Oracle, DB2 and Microsoft SQL Server right out of the box.
• ALBPM RSS Feeds Web Application allows end users to participate in business processes using their RSS Reader of choice being able to authentication and register with a specific view RSS Feed. Each View accessible through WorkSpace can be accessed from an RSS Reader like Outlook.
• PAPI WebService 1.0 has been deprecated in favor of the new PAPI WebService 2.0. PAPI-WS 1.0 is accessible through ALBPM WorkSpace while PAPI-WS 2.0 is accessible through its own new Web Application (papiws). This new version is functionally equivalent to the native Java PAPI, and adheres to the WS-Security specification using the UserNameToken Profile implementation as well as HTTP Basic Authentication.
• Native integration with AquaLogic Service Bus 2.6. You can now easily consume ALSB services from ALBPM and also register a business process in ALSB. In addition, a Custom Transport has been implemented over RMI to enforce security and transaction propagation when ALSB and ALBPM run on the same domain. This transport is provided as an Enterprise Application (.ear) which serves as a plugin for ALSB.
• Web Services in ALBPM now include support for WS-Security, Document-Literal style and WS-I compliance.

Changes and Improvements

• Configuring ALBPM Directory Service purely on top of LDAP provider is no longer possible.
• ALBPM project directories do not use the .fpr extension anymore.
• The Directory configuration file directory.properties is now XML-based and changes its name to directory.xml.
• ALBPM JSR-168 Portlets have been deprecated in favor of the new WorkSpace deployable in WebLogic Portal (WLP) 10.0 and ALUI 6.1MP1. This new interface matches the WorkSpace functionality as well as supporting SSO.
• It is now simpler to deploy ALBPM projects on WebLogic and WebSphere editions of ALBPM Engine. It is no longer necessary to generate and deploy an EAR file for each ALBPM project. Only the Engine EAR needs to reside in the J2EE container. The Engine application dynamically loads the project models and executable code from the Directory Service.
• ALBPM WorkSpace Extensions (for integration with ALUI) is now included with ALBPM Enterprise. This consolidates the installation and setup on a single install package.
WLS Single-Node Configuration

The following topics show you how to perform basic configuration of the AquaLogic BPM Enterprise on a single WebLogic managed server.

Configuration Roadmap

This topic provides a general overview of the steps required to configure ALBPM Enterprise using WebLogic Server.

1. Review the configuration prerequisites to ensure that you have installed the correct software, that your system corresponds to the minimum system requirements, and that your platform is part of the supported configurations.

   See Configuration Prerequisites Before performing a basic configuration of ALBPM Enterprise, ensure that you have met the following prerequisites. for more information.

2. Run the Configuration Wizard

   The Configuration Wizard allows you to perform the following:
   - Create the ALBPM directory database.
   - Create the ALBPM Process Execution Engine database.
   - Create and deploy ALBPM web application EAR files.

   See What is the ALBPM Configuration Wizard? on page 33 for more information on the tasks the Configuration Wizard can perform.

3. Publish and Deploy your ALBPM Project.

   Using the Process Administrator, you can publish and deploy a project exported from ALBPM Studio. See Deploying a Project on page 12.

Running the ALBPM Configuration Wizard (Single Node)

The ALBPM Configuration Wizard provides an easy way for configuring and deploying the AquaLogic BPM web applications.

When configuring ALBPM Enterprise on a single-node WebLogic Server installation, you can choose to have the ALBPM Configuration Wizard create a WebLogic Server domain.

To run the ALBPM Configuration Wizard:

1. Start the Admin Center.
2. Click Configuration.
3. Click Add.
   - The Configuration Wizard appears.
4. Run the ALBPM Configuration Wizard.
   - The following table outlines specific considerations for each page of the ALBPM Configuration Wizard. For complete reference information, see ALBPM Configuration Wizard on page 33.
### Configuration Wizard Page | Notes
--- | ---
**Configuration Wizard Tasks** | Select the following options:
- Create Directory Service
- Create Process Engine
- Publish and Deploy Sample Project
- Create ALBPM Applications EAR Files
- BEA WebLogic Configuration

**Directory Provider Type** | Select **Use a database managed by ALBPM**.
**Directory Provider Selection** | Enter the information for your database provider.
**Configure Directory Provider** | Enter connectivity information for your directory database provider.
**Enter Directory Configuration Information** | Enter the DBA user id and password.
**Process Engine Provider Selection** | Enter the information for your Process Execution Engine database provider.
**Process Engine Provider Configuration** | Enter connectivity information for your database provider.
**Enter Process Engine Creation Information** | Enter the DBA user id and password for the Process Execution Engine database.
**Select EAR Files to Create** | Select **Create new domain** and provide the connectivity information for your WebLogic Server installation.

**Note:** The specific pages that appear depend on the options you select. The table above assumes the following:
- You are configuring a new Directory and Process Execution Engine databases.
- You have DBA access privileges on these databases.
- You are creating a new WebLogic Server domain.

See *ALBPM Configuration Wizard* on page 33 for more information about other configuration options and reference information for each page of the Configuration Wizard.

---

## Deploying a Project

The following procedures describe how to deploy an ALBPM Project using the Process Administrator.

1. Click **Launch Process Administrator**.
   The Process Administrator appears in a browser window.
2. Enter the Process Administrator username and password.
3. Click **Login**.
4. Click **Projects**.
5. Click **Publish**.
   The *Publication Source* pane appears.
6. Select the Publication Source

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Project at Web Server host</strong></td>
<td>Allows you to select an ALBPM Project from the file system of the server where the Process Administrator is running.</td>
</tr>
</tbody>
</table>
### Option | Description
--- | ---
**Exported Project** | Allows you to select an exported ALBPM Project from the file system of the local computer where your web browser is running.

7. Select **Deploy processes after publishing them**.
8. Click **Ok**.

   *The Publish Process pane* appears.

9. Expand **Role Mapping**.
10. Map the roles.
11. Click **Publish**.

   *The Deployment Topology pane* appears.

12. Click **Ok**.

   To perform a basic deployment of a project, use the default values for these fields.

Your project appears in the list of deployed projects.
The following topics show you how to perform basic configuration of ALBPM Enterprise in a WebLogic Server clustered domain.

A WebLogic Server cluster consists of multiple WebLogic Server server instances running simultaneously and working together to provide increased scalability and reliability. A cluster appears to clients to be a single WebLogic Server instance. Deploying within a WebLogic cluster allows ALBPM applications to leverage WebLogic Server's built-in fail-over functionality.

See *Using WebLogic Server Clusters* for more information.

### Configuration Roadmap

1. Create a new clustered domain.
2. Run the Configuration Wizard.
3. Target the deployed web applications to other cluster members.
4. Publish and Deploy Projects

### Creating a New Domain

The first step in deploying AquaLogic BPM to a cluster is to create a domain that has multiple managed servers and at least one cluster. You can create this domain using the WebLogic Server Configuration Wizard. This wizard is part of the basic WLS installation and allows you to easily create a domain with multiple managed servers and clusters.

See *Creating WebLogic Domains Using the Configuration Wizard* for information on creating WebLogic Server domains and using the Configuration Wizard.

### Running the ALBPM Configuration Wizard (Cluster)

When running the configuration wizard, remember to select the option to deploy to an existing WLS domain. See *Configure WebLogic Server* on page 43 for more information. On this page, you should select the managed server where you want to deploy the ALBPM Web Applications.

After deploying to a single managed server, you can re-target the applications to each cluster member. See *Targeting Deployments to a Cluster* on page 11 for more information.

To run the ALBPM Configuration Wizard:

1. Start the Admin Center.
2. Click Configuration.
3. Click Add.
   
   The Configuration Wizard starts.
4. Run the Configuration Wizard as outlined in the following table:
**Configuration Wizard Page** | **Notes**
--- | ---
Configuration Wizard Tasks | Select the following options:
  - Create Directory Service
  - Create Process Engine
  - Publish and Deploy Sample Project
  - Create ALBPM Applications EAR Files
  - BEA WebLogic Configuration
Directory Provider Type | Select **Use a database managed by ALBPM**.
Directory Provider Selection | Enter the information for your database provider.
Configure Directory Provider | Enter connectivity information for your directory database provider.
Enter Directory Configuration Information | Enter the DBA user id and password.
Process Engine Provider Selection | Enter the information for your Process Execution Engine database provider.
Process Engine Provider Configuration | Enter connectivity information for your database provider.
Enter Process Engine Creation Information | Enter the DBA user id and password for the Process Execution Engine database.
Select EAR Files to Create | Select **Modify an existing and running WebLogic Server domain** and provide the connectivity information for your WebLogic Server installation.
Configure WebLogic | Note: When running the ALBPM Configuration Wizard, the managed server you are deploying to must be running. The Configuration Wizard uses WLST to deploy web applications and configure the domain.

Note: The specific pages that appear depend on the options you select. The table above assumes the following:
- You are configuring a new Directory and Process Execution Engine databases.
- You have DBA access privileges on these databases.
- You are deploying to an existing WebLogic Server domain.

See **ALBPM Configuration Wizard** on page 33 for more information about other configuration options and reference information for each page of the Configuration Wizard.

**Targeting Deployments to a Cluster**

This topic provides general procedures for retargeting deployed ALBPM web applications.

1. Login to the WebLogic Server Administration Console.
2. Retarget each of the following to each managed server in your cluster.
   - application modules
   - JDBC datasource
   - JMS queue
3. Start each managed server within your cluster.
Deploying a Project

The following procedures describe how to deploy an ALBPM Project using the Process Administrator.

1. Click **Launch Process Administrator**.
   
The Process Administrator appears in a browser window.

2. Enter the Process Administrator username and password.

3. Click **Login**.

4. Click **Projects**.

5. Click **Publish**.
   
The **Publication Source** pane appears.

6. Select the Publication Source
   
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project at Web Server host</td>
<td>Allows you to select an ALBPM Project from the file system of the server where the Process Administrator is running.</td>
</tr>
<tr>
<td>Exported Project</td>
<td>Allows you to select an exported ALBPM Project from the file system of the local computer where your web browser is running.</td>
</tr>
</tbody>
</table>

7. Select **Deploy processes after publishing them**.

8. Click **Ok**.
   
The **Publish Process pane** appears.

9. Expand **Role Mapping**.

10. Map the roles.

11. Click **Publish**.
   
The Deployment Topology pane appears.

12. Click **Ok**.
   
   To perform a basic deployment of a project, use the default values for these fields.

Your project appears in the list of deployed projects.
Integrating with AquaLogic Interaction

This section provides information for integrating AquaLogic BPM within AquaLogic User Interaction.

ALBPM provides out-of-the-box integration using WorkSpace Extensions for AquaLogic User Interaction. WorkSpace Extensions for ALI allow you to use ALBPM with the following functionality:

• Use ALI as the user interface layer for ALBPM
• Use ALI to handle user authentication
• Use ALI Collaboration as the document repository for attachments.

See What is ALBPM Enterprise? on page 4 for general information about WorkSpace Extensions.

Configuration Prerequisites

The following prerequisites should be met before installing ALBPM WorkSpace Extensions.

Required Software

Ensure that you have installed and correctly configured the following software:

• BEA AquaLogic Interaction
• BEA AquaLogic Collaboration (Optional. BPM can use ALI Collaboration as the document repository for attachments).

See the ALBPM Installation Guide for information on the supported versions of this software.

Database Access

In order to create the required database schema, you need the following information:

• Database server connectivity information.
• DBA username and password.

Running the WorkSpace Extension Configuration Wizard

The following procedures show you how to run the WorkSpace Extension Configuration Wizard.

The WorkSpace Extension Configuration Wizard is located at: BEA_HOME/albpm6.0/j2ewl/bin/weconfigwizard.exe.

1. Run the Configuration Wizard as outlined in the following table:

<table>
<thead>
<tr>
<th>Configuration Wizard Page</th>
<th>User Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALUI Database Type</td>
<td>Select the database type used by AquaLogic Interaction Portal.</td>
</tr>
<tr>
<td>ALUI Database Connection Information</td>
<td>Provide the connectivity information for the AquaLogic Interaction Portal database.</td>
</tr>
<tr>
<td>ALI Identity Service Database Type and Service Ports</td>
<td>Select the database type and service ports for the AquaLogic Interaction Identity Service (Hydrogen). You will have to create this database after running this Wizard.</td>
</tr>
<tr>
<td>ALI Identity Service Database Connection Information</td>
<td>Provide the connectivity information for the AquaLogic Interaction Identity Service (Hydrogen) database.</td>
</tr>
<tr>
<td>Show SQL Script</td>
<td>Copy the generated SQL script to the clipboard or save it to a file. You will use this script later to create the table structures for the ALI Identity Service Database.</td>
</tr>
</tbody>
</table>
The generated SQL script will be used to create the ALI Identity Service (Hydrogen) database.

### Configuring the ALI Identity Service Database

This topic describes how to create the AquaLogic Identity Service database.

1. Create the database user and database schema that will contain the ALI Identity Service tables. You will need DBA privileges to perform this step.

   **Note:** These new user id and password you create must match the ones you specified in the **ALI Identity Service Database** step of the WorkSpace Extensions configuration wizard.

   For the case of Oracle:

   1. You may create the new database user with the following script. Replace `aliis_db` and `password` with the ID and password for the new user you want to create:

      ```sql
      create user aliis_db identified by password;
      grant connect to aliis_db;
      grant resource to aliis_db;
      grant create view to aliis_db;
      ```

   2. You need to have an Oracle tablespace in place where the ALI Identity Service database indexes will be created. A standard installation of ALI defines a "PLUMINDEX" tablespace; you may reuse it for Identity Service. If you don't have a tablespace available, you may create a new one following this example SQL script (assuming the database SID is "PLUM"):

      ```sql
      REM * Create a tablespace for indexes.
      REM *
      CREATE TABLESPACE ALIIS_INDEX
      DATAFILE '$ORACLE_BASE/oradata/PLUM/aliisidx.dbf'
      SIZE 65536K REUSE AUTOEXTEND ON
      EXTENT MANAGEMENT LOCAL AUTOALLOCATE
      SEGMENT SPACE MANAGEMENT AUTO
      ;
      ```

      On Windows, the **DATAFILE** path would be:

      ```sql
      DATAFILE '%ORACLE_BASE%\oradata\PLUM\aliisidx.dbf'
      ```

   3. You must modify the SQL script generated by the WorkSpace Extension Configuration Wizard to specify the right tablespace. In the following line, replace "PROCESSINDEX" with the name of your tablespace:

      ```sql
      DEF IDX_TBSP=PROCESSINDEX
      ```

      For example, to specify the "PLUMINDEX" tablespace you should change it to:

      ```sql
      DEF IDX_TBSP=PLUMINDEX
      ```
2. Run the SQL script generated by the WorkSpace Extensions configuration wizard. You should run the script using the id of the user created in the previous steps to ensure the database objects are created on the right schema and namespace.

After running the SQL script, your database will contain the necessary ALI Identity Service tables.

Configuring the AquaLogic Identity Service

This procedure shows you how to configure the AquaLogic Identity Service for integrating ALBPM with ALUI.

**Important:** If you have a older version of ALI Identity Service installed on your system, you should un-install it first to avoid conflicts.

To install the ALI Identity Service:

1. Install the ALI Identity Service located in `BEA_HOME/albpm6.0/j2eewl/ptids/1.2/bin` using the following command:
   On Windows: `.\service.bat install`
2. Start the ALI Identity Service.
   On Windows you may start the **BEA ALI Identity Service** from the standard Windows Services panel.
   On Unix environments, you start the service with the following command:
   
   ```
   ./service.sh start
   ./service.sh console (to run on the foreground)
   ```
3. Verify that the ALI Identity Service started without errors.
   You may check the log file located at: `BEA_HOME/albpm6.0/j2eewl/ptids/1.2/logs/service.log`.
   If the service started successfully, there should be no errors and the final line of the log should state ***Initial Sync Completed***.

Deploying the .pte File

You must import the ALI (.pte) file in order to expose the WorkSpace and Process Administrator applications within the ALI Portal and access the Portal Community that hosts it. This file defines all the associations between ALI and the ALBPM environment.

The .pte file is provided with the ALBPM Enterprise and is located in `BEA_HOME/albpm6.0/j2eewl/serverpackages/ALBPM-60-ALI-template.pte`.

**Note:** If you are installing WorkSpace extensions on BEA WebLogic Server or IBM WebSphere Application Server, you must edit the Remote Server objects in the portal to point to the application server. The Remote Server Objects are located in the Remote Server section in the Process folder of the Portal Administration Console.

See the *AquaLogic Interaction Administrator Guide* for more information on how to deploy the .pte file.

Assigning Process Administrators

You must add at least one ALI user to the Process Administrator group.
1. Login to ALI's portal as an Administrator. By default, it runs on http://host:8080/portal/server.pt.

2. Click on the Administration tab. You should see a new Process folder.


4. You may add new members to the group by pressing the Add User/Group button.

**Restart ALI Services**

You must re-start ALI services to force a quick replication of users and groups information from the ALI Portal database to ALI's Identity Service (Hydrogen).

1. Re-start of ALI Services
   On Windows you may use the standard Windows Services panel to re-start the following services:
   - BEA ALI API Service
   - BEA ALI Identity Service
   On UNIX: BEA_HOME/alui/ptws/6.1/bin/apiserviced.sh restart

**Running the Configuration Wizard**

The following procedures outline how to use the Configuration Wizard to configure WorkSpace Extensions.

To run the ALBPM Configuration Wizard:

1. Start the Admin Center.
2. Click Configuration.
3. Click Add.
   The Configuration Wizard appears.
4. Run the Configuration Wizard as outlined in the following table:

<table>
<thead>
<tr>
<th>Configuration Wizard Page</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration Wizard Tasks</td>
<td>Select Create Directory Service.</td>
</tr>
<tr>
<td>Directory Provider Type</td>
<td>Select Use an external directory service provider. This is to allow ALBPM to use ALI's Identity Service as the source of users and groups.</td>
</tr>
<tr>
<td>Directory and Organization Providers Selection</td>
<td>Select the database type for the ALBPM Directory provider and select ALI Identity Service as the Organization Provider.</td>
</tr>
<tr>
<td></td>
<td>Note: The BPM Administrator User must be an existing user in ALUI within the Process Administrator Group (see Assigning Process Administrators on page 15). The user and password are case-sensitive.</td>
</tr>
<tr>
<td>Configure ALBPM Directory Provider</td>
<td>Enter connectivity information for your directory database provider.</td>
</tr>
<tr>
<td>Configure Organization Provider</td>
<td>Enter the connectivity information for your ALI Identity Service.</td>
</tr>
<tr>
<td>Enter Directory Creation Information</td>
<td>Enter the DBA user ID and password for the directory database and the organization logical name.</td>
</tr>
<tr>
<td></td>
<td>Note: If you have chosen to generate SQL scripts, only the organization logical name appears on this screen.</td>
</tr>
</tbody>
</table>
Verifying Your Installation

Follow this procedure to verify the configuration of ALBPM WorkSpace Extensions for ALUI.

1. Start ALBPM Web Applications.
   
   See *Starting BPM Web Applications* for more information.

2. Verify that the ALBPM Process Administrator is correctly configured.
   
   a) Login to ALI's Portal as a user in the Process Administrator group. By default, it runs on http://host:8080/portal/server.pt.
   b) Click on the Administration tab.
   c) Select Process Administrator from the Select Utility... drop down.
   d) You can go to Organization ➤ Participants and Organization ➤ Groups to verify that the ALI users appear as ALBPM Participants.

3. Verify that your Process Execution Engine is up and running.
   
   a) In the Process Administrator click on Engines. Verify that the Status of your Engine (by default named albpengine) is Running.

   If the Engine status is Not Running, try to start it by clicking on the Start icon (▶).

   Note: If the Engine fails to start, click on the Start-up log icon (Ξ) to look for errors.

   Note: By default, the Process Execution Engine uses TCP port 10099 to accept client connections. If ALBPM is running on the same box as the ALI components, you might need to change this default TCP port to avoid conflicts. To change this port click on albpengine ➤ Engine Nodes ➤ [your_node_host] and change the Port field.

4. Verify that the Process Portal Community is correctly configured.
a) Click the **My Communities** drop-down option
b) Select **Process Community**.

The ALBPM WorkSpace appears in the main Portal window.
WebLogic Portal Configuration

The following sections show you how to configure AquaLogic BPM to work with the WebLogic Portal.

Configuration Roadmap

1. Ensure that you have performed the installation prerequisites outlined in Configuration Prerequisites on page 19.
2. Configure WebLogic Server and WebLogic Portal domains.
   You can configure ALBPM to work with the following domain configurations:
   • Separate WebLogic Server and WebLogic Portal domains
   • A single domain shared by WebLogic Server and WebLogic Portal
3. Configure the ALBPM WorkSpace WAR file.
   You must create the WorkSpace application WAR using the ALBPM Process Administrator. After creating this WAR, you must manually edit and re-archive it.
4. Create a new Portal
5. Update the Portal Web Project
6. Disable JSP Validation
7. Refresh the Web Project
8. Create the ALBPM Portlets.
   These portlets allow you to see the process instances of a deployed ALBPM project.
9. Create the Login Portlet.
10. Verify your installation.
   After performing these steps, you should be able to see your deployed ALBPM Processes within a WebLogic Portal.

Configuration Prerequisites

This section describes the configuration prerequisites for integrating AquaLogic BPM with WebLogic Portal.

Required Software

Ensure that you have installed and correctly configured the following software:

• BEA WebLogic Server
• BEA WebLogic Portal
• BEA AquaLogic BPM

See the ALBPM Installation Guide for information on the supported versions of this software.

Note: You must also ensure that you have installed the most recent patches for each of these applications.
WebLogic Portal and AquaLogic BPM User Base
You must ensure that the user bases for your WebLogic Portal and ALBPM installations are synchronized, including administrators.

Database Access
In order to create the required database schema, you need the following information:
• Database server connectivity information.
• DBA username and password.

Configuring Domains
When integrating AquaLogic BPM and WebLogic Portal, you have two domain configuration options.
• Single Domain: Allows you to use one domain for the WebLogic Server and WebLogic Portal installations. This method is easier to configure and is used for testing and evaluation. However, it is not ideal for production environments.
• Multiple Domain: Allows you to use separate domains for the WebLogic Server and WebLogic Portal installations. This method requires you to configure trust between the domains. This method is recommended for production environments.

Configuring a Single Domain
The following procedures show how to configure AquaLogic BPM and WebLogic Portal integration using a single domain.

The BEA WebLogic Configuration Wizard allows you to easily create and configure a new WebLogic Server domain.

1. Start the BEA WebLogic Configuration Wizard
2. Using the following table as a guide, complete each screen of the wizard:

<table>
<thead>
<tr>
<th>Wizard Screen</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Welcome</td>
<td>Select <strong>Create a New WebLogic Domain</strong></td>
</tr>
<tr>
<td>Select Domain Source</td>
<td>Choose Generate a domain configured automatically, then select the following:</td>
</tr>
<tr>
<td></td>
<td>• WorkShop for WebLogic Platform</td>
</tr>
<tr>
<td></td>
<td>• WebLogic Portal</td>
</tr>
<tr>
<td>Configure Administrator Username and Password</td>
<td>Enter the domain administrator username and password. For simplicity in a testing environment, it is recommended that you use weblogic/weblogic.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Note:" /> This username must also exit in the ALBPM user base.</td>
</tr>
<tr>
<td>Configure Server Start Mode and JDK</td>
<td>Select the Jrockit SDK</td>
</tr>
<tr>
<td>Customize Environment and Services Settings</td>
<td>Choose <strong>No</strong>.</td>
</tr>
<tr>
<td>Create WebLogic Domain</td>
<td>Enter the domain name. You will point to this domain when running the ALBPM Configuration Wizard.</td>
</tr>
<tr>
<td>Creating Domain</td>
<td>Select <strong>Done</strong> after the domain has been created.</td>
</tr>
</tbody>
</table>

3. Start the Administration Server
When running the ALBPM Configuration Wizard in the next step, the Administration Server must be running. This also allows you to verify that your domain was created and configured successfully.

Running the ALBPM Configuration Wizard

The following procedures show how to use the ALBPM Configuration Wizard to configure a domain for integration with WebLogic Portal.

1. Launch the AquaLogic BPM Admin Center
2. Click Configuration.
3. Click Add.
   
   The ALBPM Configuration Wizard starts.
4. Complete each screen of the wizard using the following table as a guide:

<table>
<thead>
<tr>
<th>Wizard Screen</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration Wizard Tasks</td>
<td>Select the default options</td>
</tr>
<tr>
<td>Directory Provider Type</td>
<td>Select Use a database managed by ALBPM</td>
</tr>
<tr>
<td>Directory Provider Selection</td>
<td>Enter the information for your database provider.</td>
</tr>
<tr>
<td>Configure Directory Provider</td>
<td>Enter connectivity information for your directory database provider.</td>
</tr>
<tr>
<td>Enter Directory Creation Information</td>
<td>Enter the DBA user id and password. You must also select Enable SSO.</td>
</tr>
<tr>
<td>Process Engine Provider Selection</td>
<td>Enter the information for your Process Execution Engine database provider.</td>
</tr>
<tr>
<td>Process Engine Provider Configuration</td>
<td>Enter connectivity information for your database provider.</td>
</tr>
<tr>
<td>Enter Process Engine Creation Information</td>
<td>Enter the DBA user id and password for the Process Execution Engine database.</td>
</tr>
<tr>
<td>Select EAR Files to Create</td>
<td>Ensure that all of the application EAR files are select. All application EARs are required for WebLogic Portal integration.</td>
</tr>
<tr>
<td>Configure WebLogic</td>
<td>Select Modify an existing and running WebLogic Domain, then enter the information for your domain. Note the following:</td>
</tr>
<tr>
<td></td>
<td>• Server Name should be the name of the Administration Server for your domain. AdminServer is the default. If you have changed this during the domain config wiz, enter the new value here</td>
</tr>
<tr>
<td></td>
<td>• Domain Name is the name of the domain you configured previously.</td>
</tr>
<tr>
<td></td>
<td>• Domain Folder is the location on the filesystem where you domain is saved.</td>
</tr>
<tr>
<td></td>
<td>• WebLogic admin and password are identical to those you specified during domain creation.</td>
</tr>
<tr>
<td>ALBPM Configuration Complete</td>
<td>Click Finish.</td>
</tr>
</tbody>
</table>

For comprehensive information using each screen of the wizard, see ALBPM Configuration Wizard on page 33.
Configure Single Sign On (SSO)

The following procedures show you how to configure Single Sign On (SSO) when integrating AquaLogic BPM with WebLogic Portal.

Single Sign On (SSO) allows a user to access more than one application, while providing login information once.

1. Launch the AquaLogic BPM Admin Center
2. Click Configuration.
3. Click the WorkSpace tab.
4. Select Enable SSO.
5. Click Ok.

Creating the ALBPM Application Files

ALBPM WorkSpace is designed to perform authentication by itself. To use WorkSpace within a WebLogic Portal container, ALBPM authentication must be container-based. This requires you to configure the ALBPM Directory Service to work in trusted mode. WorkSpace must also be configured to support this configuration from a client perspective.

The following procedures show you how to create and configure the ALBPM WorkSpace WAR file. After creating the WAR file, you must expand, edit, and reassemble it.

1. Launch the ALBPM Admin Center
2. Select Start BPM Applications.
3. Click Launch Process Administrator.
4. Provide Login information.
5. Click Engines in the left hand pane.
6. Click the engine whose WAR file you want to generate.
7. Click J2EE Application Server File.
8. Click the icon next to BEA AquaLogic BPM WorkSpace WAR.
   The ALBPM WorkSpace WAR file is generated and the link appears under the explanation.
9. Right-click 08-workspace-wp-FDIDS.war, then select Save Link As.
10. Select a location to save the WAR file.
11. Click Logout.

Deploying the WAR File in WebLogic Portal

The following procedures show you how to deploy the modified WAR file in WebLogic Portal using WorkShop for WebLogic Platform.

2. Select a workspace, then click Ok.
3. Click Workbench
4. Create a new WebLogic Portal Ear project.
   a) Select File ➤ New ➤ Other
   b) Expand WebLogic Portal
c) Select Portal Ear Project, then click Next.

d) Provide a project name, then click Next.

e) Ensure that the following are selected:
   • EAR
   • WebLogic EAR Extensions
   • WebLogic Portal

f) Click Finish.

5. Create a Portal Web Project

You must add this project to the Portal EAR project created in the previous step. You must also select JSF from Project Facelets when creating the Web Project.

a) Select File ➤ New ➤ Portal Web Project

b) Enter the Project Name

c) Check the Add project to an EAR checkbox.

d) Select the EAR file edited in previous tasks.

e) Click Next.

f) Ensure that the JSF option is selected.

g) Click Next.

h) Click Finish.


This must point to the same WebLogic Portal domain created earlier.

a) Open the Server View.

b) Right click in the view, then select New ➤ Server

c) Select WebLogic Server 10.

d) Click Next.

e) Click Browse, then select the WebLogic Portal domain.

   This must be the WebLogic domain created earlier. If you are using a two domain configuration, then this must be the WebLogic Portal domain created earlier.

f) Click Ok.

g) Click Next.

h) Select the EAR file edited previously.

i) Click Add.

   This adds the EAR to the list of configured projects.

j) Click Next.

k) Click Finish.

Updating the Portal Web Project

The following procedures show you how to merge the ALBPM WAR file with the WebLogic Portal WAR file. You must manually copy elements from the AquaLogic BPM WAR file to the WebLogic Portal Web Content directory.

During this manual merge process, it is important to remember the source and destination location of the files.

• **Source:** The ALBPM WAR file which was generated earlier in Creating the ALBPM Application Files on page 22.

• **Destination:** The WebLogic Portal Web Content directory. This directory is usually located at: BEA_HOME/user_projects/w4WP_workspaces/wlpPortalProject/WebContent

1. Expand 08-workspace-wlp-FDIDS.war.
2. Copy the following folders and their contents from the source WAR to the Portal Project Web Content folder:
   - charts/*
   - css/*
   - help/*
   - img/*
   - js/*
   - jsf/*
   - jsp/*

3. Copy the WEB-INF/facelets folder from the source WAR to the Portal Project WebContent folder.

4. Copy all files from WEB-INF/classes to the WEB-INF/classes folder in the Portal Project WebContent folder.

5. Copy all the files under WEB-INF/lib to the WEB-INF/lib folder in the Portal Project WebContent folder.

6. Copy the following files from the source WAR to the WEB-INF target in the Portal Project WebContent folder:
   - /WEB-INF/application.xml
   - /WEB-INF/bmpWorkspace.tld
   - /WEB-INF/components.xml
   - /WEB-INF/directory.xml
   - /WEB-INF/htmlComponents.xml
   - /WEB-INF/managed-beans.xml
   - /WEB-INF/navigation.xml
   - /WEB-INF/workspace.properties

7. Update the WebLogic Portal's web.xml
   A revised version of web.xml is available at: http://edocs.bea.com/albsi/docs60/resources/workspace_wlp/web.xml. For a listing of the contents of this file, see Example web.xml for WebLogic Portal on page 44

Disabling JSP Validation

The following procedures show you how to disable JSP validation.

1. Right-click on the Portal Web Project
2. Click Properties.
3. In the left-hand tree, click Validation.
4. Unselect the Build column for the JSP Syntax Validator.
5. Click Apply.
6. Click Ok.

Refreshing the Web Project

To ensure that all of your configuration changes have taken effect, you must refresh and validate the Portal Web Project.

1. Right-click on the Portal Web Project, then select Refresh.
   This may take a few minutes while the workspace is rebuilt.
2. Right-click on the Portal Web Project, then select Validate.

The Portal Web Project should refresh with no errors.
Creating ALBPM Portlets

The following tasks show you how to create ALBPM Portlets using BEA Workshop for WebLogic Platform.

1. Create a new Portlets folder Portal Web Project.
   a) In the Project Navigator view, expand your Web Portal Project folder
   b) Right-click the WebContent folder
   c) Select New ➤ Folder
   d) Enter portlets in the Folder Name field.
      ❧ Note: This folder must be named portlets in all lower case to avoid resource conflicts.
   e) Click Finish.

2. Create each of the portlets listed in the following table:

<table>
<thead>
<tr>
<th>Portlet</th>
<th>Template Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actions Menu</td>
<td>/jsf/menu/menuActionPortlet.xhtml</td>
</tr>
<tr>
<td>Views Menu</td>
<td>/jsf/menu/menuViewPortlet.xhtml</td>
</tr>
<tr>
<td>Work List</td>
<td>/jsf/view/viewPresentationPortlet.xhtml</td>
</tr>
<tr>
<td>Instance Detail</td>
<td>/jsf/view/instance/viewInstanceDetailPortlet.xhtml</td>
</tr>
</tbody>
</table>

To create these portlets, perform the following procedures. You must repeat these procedures for each type of portlet above.
   a) Right-click on the portlets folder created in the previous step.
   b) Select New ➤ Portlet
      The New Portlet window appears.
   c) Enter the name of your new portlet.
      ❧ Note: To avoid confusion, you should name your new portlet according to the type mentioned in the table above.
      The Portlet Wizard appears.
   d) Select Java Server Faces (JSF) Portlet.
   e) Click Next.
   f) Provide details for your portlet.
      • Title: For simplicity, provide a title that corresponds to the titles listed in the table above.
      • Content Path: Provide the location of the portlet template. For each portlet type, the template location is listed in the table above. You can copy this location from the table to the Content Path field.
   g) Click Create.
      The new portlet appears in the editor window. You must repeat these procedures for each type of portlet listed in the table above.

In order to view these portlets, you must install a Login portlet provided by BEA. The portlets created above are added to the login portlet. See Creating ALBPM Portlets on page 25 for more information.
Creating Login Portlet

1. Download the Login portlet from the Dev2Dev website.
   This portlet is available at:
   https://codesamples.projects.dev2dev.bea.com/servlets/Scarab/remcurreport/true/template/ViewIssue.vm/id/S275/nbrresults/47
   under the Attachments tab.
   You should download this portlet and save it to a location where you can import it in the following steps.

2. Import the Login portlet.
   a) Right-click on the Portal Web Project
   b) Select Import ➤ Import.
   c) Expand General.
   d) Select Archive File.
   e) Click Next.
   f) Click Browse.
   g) Select the Login portlet downloaded above.
   h) Click Open.
   i) Click Finish.

3. Expand the Portal Web Project
4. Right-click on the WebContent folder
5. Select New ➤ Portal
   The New Portal page appears.
6. Provide a name for the new portal.
   The new portal appears in the editor window.
7. Set the layout type for the new portlet.
   ❗ Note: You must ensure that you are not using any of the flow layouts.
   a) Right-click in the portlet editor window.
   • Select Layout ➤ Single Column Layout

8. Rename the default page to Login in the Properties view.
9. Add the Login portlet imported above to the Login page by dragging it from the Project Navigator view.
10. Right-click in the portal editor window
11. Select Insert ➤ New Page
12. In the Properties view, change the Layout Type to Two Column Layout.
13. In the Properties view, change the Page title to ALBPM.
14. Add the ALBPM Portlets to the ALBPM page by dragging them from the Project Navigator view.
15. Save the Portlet.
16. Republish the server from the Servers view.

After performing the steps above, you should be able to start the WebLogic Portal using the portal and portlets.
Verifying your Installation

This section shows you how to test your configuration of the ALBPM WorkSpace using the WebLogic Portal.

1. Start the WebLogic Server instance configured to run ALBPM and WebLogic Portal.
2. Ensure that your WebLogic Portal and ALBPM user bases are synchronized.
3. Deploy a sample ALBPM Project using the Process Administrator.
   ALBPM example projects are located in the Samples directory of you ALBPM installation. See Deploying a Project on page 12 for more information.
4. Open the WebLogic Portal URL
   To access the WorkSpace within WebLogic portal, use the following URL:
   http://host:port/your_portal_project/portal_file
   For example: http://localhost:7001/wlpPortalProject/albpm.portal
5. Login to the WebLogic Portal using weblogic as the username and password.
   \( \textbf{Note:} \) You must ensure that this user has been created using the ALBPM Process Administrator and has been granted the proper roles.
6. Select the ALBPM Page.
   The ALBPM portlets appear containing the activities of the sample project you deployed.
BAM and Data Mart Configuration

BAM (Business Activity Monitoring) and Business Activity Data Mart data is a collection process load and execution time of measurements. The BAM database maintains current information, while the Data Mart database stores historical series.

Overview

BAM and Data Mart data is derived from audited events, and therefore depends on how audit event generation is configured. When enabling either BAM or the Data Mart, it will help you to understand event generation options. See Audit Events Overview on page 48.

The BAM and the Data Mart databases use similar (but not identical) schemas and are separate from the engine database. Neither is required for process execution, so you only need to configure a BAM or a Data Mart database if you intend to use it.

Configuration Steps

You must perform the following tasks to configure either BAM or Data Mart process monitoring services:

- Add the external resource reference
- Create the database
- Select the database external resource
- Enable automatic update

If you will set up both BAM and the Data Mart, you will need to do the preceding steps twice (once for each service). The steps below are common to both services:

- Configure process monitoring properties
- Install (depending on system) and start the updater service

You perform nearly all of these steps in the Process Administrator. The only exception is the updater service, which you must manage separately.

Updater Service

The process execution engine does not write data to the BAM and Data Mart databases. Instead, a separate updater service does the job. Although the BAM and Data Mart databases are independent, the same service updates both.

Adding the BAM or Data Mart Database External Resource

To configure a BAM or Data Mart, you must first add the corresponding database external resource.

To add the BAM or Data Mart database external resource:

1. In the navigator, click External Resources.
2. In the External Resources pane, click on the Add button.
   The Add External Resource pane will appear.
3. In the Name field, enter a name for the data mart database, such as ALBPMDdataMart.
4. In the Type drop-down list, select SQL Database.
5. In the Subtype drop-down list, select the database driver appropriate for your database.

   When configuring an external resource for BAM and Data Mart data, you may only choose one of the following database drivers:

7. Specify the database properties in the Properties section.
Most properties are common to all the supported databases, but some are database specific. The following table describes each property:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>Name or IP address of the host (real or virtual machine), where the database resides.</td>
</tr>
<tr>
<td>Port</td>
<td>Port number to connect to the database.</td>
</tr>
<tr>
<td>Schema</td>
<td>Enter the name of the database schema, for example, you could name the Data Mart database schema ALBPMDataMart. Required for IBM DB2 and Oracle.</td>
</tr>
<tr>
<td>Database</td>
<td>Enter the name of the database, for example, you could name the Data Mart database ALBPMDataMart. Required for Microsoft SQL Server. Optional for Oracle.</td>
</tr>
<tr>
<td>SID</td>
<td>System Identifier. Required for Oracle only.</td>
</tr>
<tr>
<td>User</td>
<td>Enter a user name to be used by the updater service to connect to the database.</td>
</tr>
<tr>
<td>Password</td>
<td>Password for the user described above.</td>
</tr>
</tbody>
</table>

If you are setting properties to connect to an Oracle database, an Advanced section appears. In this section, you can specify the Tablespace, Temporary Tablespace, and Profile properties.

8. Set runtime and connection pool properties in their respective sections. Unless you have a specific requirement, you can leave the defaults.

9. If you must specify any additional connection properties, click Add and enter the property name and value. To remove an unneeded property, select the property's checkbox and click Delete.

10. Click Save.
The external resource is created.

You have added the external resource, but this step only makes ALBPM aware of the database properties. It does not create the database. You must create the database in a separate step. See Creating the BAM or Data Mart Database on page 31.

### Configuring the Data Mart

You configure the Business Activity Data Mart from the Process Monitoring page of Process Administrator.

The Data Mart properties page includes properties common to both the Data Mart and BAM.

To configure Data Mart properties:

1. In the navigator, click Process Monitoring.
   The Process Monitoring page will appear.
2. In the Process Data Mart pane, set the properties as described below:
**Configuring BAM**

You configure BAM from the **Process Monitoring** page of Process Administrator.

Before configuring BAM, you should have added the external resource reference to the BAM database, and you should have created the BAM database itself.

To configure BAM properties:

1. In the navigator, click **Process Monitoring**.
   
   The **Process Monitoring** page will appear.

2. In the **BAM** pane, set the properties as described below:

   **Property Name** | **Description**
   --- | ---
   Enable Automatic Update | If selected, the updater service will update the BAM database.
   Updater Database Configuration | Name of the external resource which points to the database where BAM information is stored.
   Update Frequency | The time that will elapse between updates, in minutes.
   Data Expiration Time | BAM data will expire after this period and be removed. Recall that BAM is meant for monitoring of current activity. If you want longer term measurements, use the Data Mart. This value is set in hours, and the default is 24.

3. Click **Save**.
Creating the BAM or Data Mart Database

Before enabling BAM or the Data Mart, you must create their respective databases. You can use Process Administrator to either create the database directly, or to generate an SQL script for execution by a database administrator.

Before you can create a BAM or Data Mart database, you should have added the external resource for it. See Adding the BAM or Data Mart Database External Resource on page 28.

The following instructions assume you are logged in to Process Administrator. You must perform these steps for each service you will use (BAM and Data Mart).

To create a BAM or Data Mart database:

1. Click on Process Monitoring.
   The Process Monitoring page appears.
2. Select the BAM or Data Mart tab.
3. In the Advanced Properties section, click Manage Database.
   The Manage Database page appears.
4. Select the Create the database and Create the data structure options.
5. If you have administrator access to the database, enter the database administrator user and password, and click OK.
   If Process Administrator reports that the database has been created successfully, you are done. The instructions below are for users without administrator access to the database.
6. If you do not have administrator access, click Show SQL Statements.
   Your web browser will ask you if you want to save the sql.txt file.
7. Save the file to any location, and send it to the database administrator, who will run the SQL statements in the file, creating the database.

Dropping the BAM or Data Mart Database

After you disable BAM or the Data Mart, you can drop the respective database. You can use Process Administrator to either drop the database directly, or to generate an SQL statement for execution by a database administrator.

Bear in mind that dropping the database only executes a DROP DATABASE SQL statement on the BAM or Data Mart database. It does not remove the external resource.

1. Click on Process Monitoring.
   The Process Monitoring page appears.
2. Select the BAM or Data Mart tab.
3. In the Advanced Properties section, click Manage Database.
   The Manage Database page appears.
4. Select the Drop the database.
5. If you have administrator access to the database, enter the database administrator user and password, and click OK.
   If Process Administrator reports that the database has been dropped successfully, you are done. The instructions below are for users without administrator access to the database.
6. If you do not have administrator access, click Show SQL Statements.
   Your web browser will ask you if you want to save the sql.txt file.
7. Save the file to any location, and send it to the database administrator, who will run the SQL statement in the file, creating the database.

Note that this file will contain a single statement in the form:

DROP DATABASE database_name
You may simply be able to ask your DBA to drop the database by name. The advantage of sending an SQL file is to prevent dropping a similarly named database.

Configuring the Updater Service

BAM and Data Mart data is obtained and recorded by the ALBPM DataWarehouse service.

The updater service runs independently from the process execution engine, and may continue to run if the engine has stopped, or be stopped while the engine is running. The updater service does require access to the process engine database.

Instructions for running, stopping and configuring the updater service depend on the operating system.

Starting and Stopping the Updater Service in Unix

In Unix-like operating systems, the updater service is started and stopped with the albpmwarehouse.sh shell script.

To start or stop the updater service:

1. At a shell prompt, execute the following to start the updater service:

   ```
   $ALBPM_HOME/bin$ ./albpmwarehouse.sh start
   ```

   The updater service will start.

2. To stop the service, execute the following:

   ```
   $ALBPM_HOME/bin$ ./albpmwarehouse.sh stop
   ```

   The updater service will stop.

Installing and running the Updater Service in Windows

Under Microsoft Windows, you must install the updater service before it can run. You then control the updater service from the Windows Services console.

To install the updater service in Windows:

1. Goto the ALBPM_HOME\bin folder

   In default Windows installations, the ALBPM_HOME folder is as follows:

<table>
<thead>
<tr>
<th>Path</th>
<th>Edition</th>
</tr>
</thead>
<tbody>
<tr>
<td>C:\bea\al bpm6.0\enterprise</td>
<td>Standalone</td>
</tr>
<tr>
<td>C:\bea\al bpm6.0\j2ewl</td>
<td>BEA WebLogic</td>
</tr>
<tr>
<td>C:\bea\al bpm6.0\j2ews</td>
<td>IBM WebSphere</td>
</tr>
</tbody>
</table>

2. To install the updater service, enter the following at the command line prompt: albpmwarehouse install

   Once the updater service is installed, you can control it from the Windows Services console. The service is called ALBPM 6.0 DataawareHouse Service.

   Note: The updater service startup is installed set to Automatic, but is not started upon installation. You should start the service manually from the Services console. The service will then start automatically on system startup.

3. To remove the updater service, enter the following: albpmwarehouse remove
Enterprise Configuration Reference

The following sections contain reference information for ALBPM Enterprise configuration.

ALBPM Configuration Wizard

The following topics provide general information about the AquaLogic BPM Configuration Wizard. They also provide reference information for screen.

What is the ALBPM Configuration Wizard?

The ALBM Configuration Wizard provides a simple way of configuring ALBPM Enterprise.

The Configuration Wizard lets you choose between the following:

- Whether you want to create a new directory provider database or use an existing one. If you choose to create a new database, you can determine one of the following:
  - The Configuration Wizard adds a new database for you.
  - The Configuration Wizard generates SQL scripts that can be run by your DBA.
- Whether to create a new ALBPM Process Execution Engine database or use an existing one. If you choose to create a new database, you can determine one of the following:
  - The Configuration Wizard adds a new database for you.
  - The Configuration Wizard generates SQL scripts that can be run by your DBA.
- Whether to Publish and Deploy a sample project.
- Whether to use a single ALBPM database or a combination database and external directory provider.

When installing ALBPM Enterprise on BEA WebLogic Server, you can use the ALBPM Configuration Wizard to perform the following:

- Create the ALBPM Directory database
- Create the ALBPM Process Execution Engine database
- Create the ALBPM web application EAR files
- Create a JDBC data source
- Create a JMS server and queue
- Deploy the ALBPM web applications to a server

Running the ALBPM Configuration Wizard

The following procedures show you how to use the Configuration Wizard. The exact path depends on the options you choose.

1. Determine what tasks you want the configuration Wizard to perform.
   This allows you to define the tasks performed. See Configuration Wizard Tasks on page 34.
2. Determine if you want to use a database only or a hybrid.
   See Directory Provider Type on page 35.
3. Enter information about your directory provider type.
   See Directory Provider Selection on page 35. If you have chosen to implement the
4. Enter connectivity information about your database.

Provider | More information
---|---
Oracle | Configure Directory Provider - Oracle on page 35
DB2 | Configure Directory Provider - DB2 on page 36
SQL Server | Configure Directory Provider - SQL Server on page 37

5. Enter connectivity information for your external organization provider.

Note: This page appears only when you have chosen to configure an external directory service for your organizational data.

6. Enter one of the following:
   - If you have selected to have the Configuration Wizard create the database, provide information DBA username and password.
   - If you have selected to generate SQL script, enter org log name.

7. If you have selected to generate SQL scripts, you can choose to save it as a file or you can copy and paste it to a file.

8. Select the type of database you want to use for your Process Execution Engine database

9. Enter connectivity information for your Process Execution Engine database

10. If you have selected to have the Configuration Wizard create the database, provide information DBA username and password.

11. If you have selected to generate SQL scripts, you can choose to save it as a file or you can copy and paste it to a file.

12. Select the EAR files you want to create and deploy

13. Provide connectivity information for your WebLogic Server Installation

**ALBPM Configuration Wizard Reference**

The following topics provide detailed information for each page of the Configuration Wizard

**Configuration Wizard Tasks**

This page allows you to specify the tasks performed by the Configuration Wizard. These tasks can be grouped according to the following:

- Configure the ALBPM Directory Service Database.
- Configure the ALBPM Process Engine Database.
- Generate the EAR files for each ALBPM application.
- Create a new single-node WebLogic Server domain

You can determine which of these the Configuration Wizard performs by selecting from the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Directory Service</td>
<td>Allows you to create a new ALBPM Directory Service</td>
</tr>
</tbody>
</table>
| Use Existing Directory Service | Allows you to use an existing ALBPM Directory Service.  
  Note: If you choose to use an existing directory service, it must be created using the current version of AquaLogic BPM. |
<p>| Generate Directory Service SQL Script only | Generates a SQL script that can be used to configure the database server and schema. Use this option if you do not have DBA permissions on the database. The generated scripts can be used by your DBA. |
| Create Process Engine | Allows you to create the Process Execution Engine database using the Configuration Wizard |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate Process Engine SQL Script only</td>
<td>Generates a SQL script that can be used to configure the database server and schema. Use this option if you do not have DBA permissions on the database. The generated scripts can be used by your DBA.</td>
</tr>
<tr>
<td>Publish and Deploy Sample Project</td>
<td>Allows the Configuration Wizard to publish and deploy ALBPM sample projects. This option is only available if you select to create the Process Execution Engine database.</td>
</tr>
<tr>
<td>Create ALBPM Applications EAR Files</td>
<td>Generates the EAR files for each ALBPM Enterprise application.</td>
</tr>
<tr>
<td>BEA WebLogic Configuration</td>
<td>Configures WebLogic Server and deploys the ALBPM Enterprise applications.</td>
</tr>
</tbody>
</table>

**Directory Provider Type**

This page allows you to specify how the directory provider is configured.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use a database managed by ALBPM</td>
<td>Uses only a database to store directory and process information.</td>
</tr>
</tbody>
</table>
| Use an external directory service provider plus a database managed by ALBPM | Uses both a database and directory service provider to store directory and process information.

**Note:** When configuring WorkSpace Extensions, you must choose this option to select the AquaLogic Interaction Identity Service (Hydrogen).

**Directory Provider Selection**

This page allows you to define the general information about the Directory Service Provider.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Directory Configuration Name</td>
<td>Defines a label used to refer to this configuration within Admin Center.</td>
</tr>
<tr>
<td>Description</td>
<td>Provides a useful description for the new directory service configuration.</td>
</tr>
<tr>
<td>Directory Provider</td>
<td>Specifies the database driver for the database used as directory provider.</td>
</tr>
<tr>
<td>BPM Administrator User</td>
<td>Defines the BPM Administrator user ID.</td>
</tr>
</tbody>
</table>

**Note:** The Configuration Wizard creates this new user ID in the database.

**Note:** When configuring WorkSpace Extensions, this administrator ID must also be defined in the AquaLogic Integration Portal.

| BPM Administrator Password                   | Defines the BPM Administrator password.                                                                                                                   |

**Configure Directory Provider - Oracle**

**Basic Tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>Specifies either the IP address or the hostname of the database server.</td>
</tr>
<tr>
<td>Port</td>
<td>Specifies the TCP port of the listener running on the database server. The default is 1521, which is the default port number when installing the Oracle database software.</td>
</tr>
</tbody>
</table>
Option | Description
--- | ---
User | Defines the user id used to connect to the database.
Password | Defines the password for the user id used to connect to the database. This password is case-insensitive.
SID | Specifies the Oracle System Identifier that refers to the instance of the Oracle database running on the server.
Schema | Optionally, specifies the name of the schema used.
URL | Defines the URL format to connect to the database.

**Advanced Tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tablespace</td>
<td>Specifies the tablespace within the ALBPM database.</td>
</tr>
<tr>
<td>Temporary Tablespace</td>
<td>Specifies the temporary tablespace within the ALBPM database.</td>
</tr>
<tr>
<td>Profile</td>
<td>Specifies the profile for the ALBPM database. Profiles are as a way to limit which users can connect to the database.</td>
</tr>
</tbody>
</table>

**Properties**

This tab allows you to specify additional properties that are supported by the JDBC driver. Properties are defined using name/value pairs.

**Runtime**

The following runtime configuration properties can be defined for this database:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Pool Size</td>
<td>Specifies the maximum number of connections within the connection pool.</td>
</tr>
<tr>
<td></td>
<td>Database connections are grouped together within a connection pool to improve performance.</td>
</tr>
<tr>
<td>Maximum connections per user</td>
<td>Specifies the maximum number of connections within the connection pool for each user.</td>
</tr>
<tr>
<td>Connection Idle Time (minutes)</td>
<td>Specifies how long a connection can be idle before it times out.</td>
</tr>
<tr>
<td>Minimum Pool Size</td>
<td>Specifies the minimum number of connections with the connection pool.</td>
</tr>
<tr>
<td>Maximum Opened Cursors</td>
<td>Specifies how many queries can be created for each connection.</td>
</tr>
</tbody>
</table>

These properties define the JDBC connection handling for ALBPM components when running outside a J2EE (for example, WebLogic Server). When running within a J2EE container, database connectivity information is supplied by the container itself.

**Configure Directory Provider - DB2**

This page defines the connection properties for the ALBPM directory database.

**Basic Tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>Specifies either the IP address or the hostname of the database server. For example, 122.23.15.12 or ALBPMDatabase.</td>
</tr>
</tbody>
</table>
### Properties Tab

This tab allows you to specify additional properties that are supported by the JDBC driver. Properties are defined using name/value pairs.

### Runtime

The following runtime configuration properties can be defined for this database:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Pool Size</td>
<td>Specifies the maximum number of connections within the connection pool. Database connections are grouped together within a connection pool to improve performance.</td>
</tr>
<tr>
<td>Maximum connections per user</td>
<td>Specifies the maximum number of connections within the connection pool for each user.</td>
</tr>
<tr>
<td>Connection Idle Time (minutes)</td>
<td>Specifies how long a connection can be idle before it times out.</td>
</tr>
<tr>
<td>Minimum Pool Size</td>
<td>Specifies the minimum number of connections with the connection pool.</td>
</tr>
<tr>
<td>Maximum Opened Cursors</td>
<td>Specifies how many queries can be created for each connection.</td>
</tr>
</tbody>
</table>

These properties define the JDBC connection handling for ALBPM components when running outside a J2EE (for example, WebLogic Server). When running within a J2EE container, database connectivity information is supplied by the container itself.

### Configure Directory Provider - SQL Server

### Basic Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>Specifies either the IP address or the hostname of the database server.</td>
</tr>
<tr>
<td>Port</td>
<td>Specifies the port of the listener running on the database server.</td>
</tr>
<tr>
<td>User</td>
<td>Defines the user id used to connect to the database.</td>
</tr>
<tr>
<td>Password</td>
<td>Defines the password for the user id used to connect to the database.</td>
</tr>
<tr>
<td>Database</td>
<td>Specifies the name of the database.</td>
</tr>
<tr>
<td>URL</td>
<td>Defines the URL format to connect to the database.</td>
</tr>
</tbody>
</table>

### Properties Tab

This tab allows you to specify additional properties that are supported by the JDBC driver. Properties are defined using name/value pairs.
### Runtime

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Pool Size</td>
<td>Specifies the maximum number of connections within the connection pool. Database connections are grouped together within a connection pool to improve performance.</td>
</tr>
<tr>
<td>Maximum connections per user</td>
<td>Specifies the maximum number of connections within the connection pool for each user.</td>
</tr>
<tr>
<td>Connection Idle Time (minutes)</td>
<td>Specifies how long a connection can be idle before it times out.</td>
</tr>
<tr>
<td>Minimum Pool Size</td>
<td>Specifies the minimum number of connections with the connection pool.</td>
</tr>
<tr>
<td>Maximum Opened Cursors</td>
<td>Specifies how many queries can be created for each connection.</td>
</tr>
</tbody>
</table>

### Configure Organization Provider - Active Directory

#### Basic Tab

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial Context Factory</td>
<td>Specifies the JNDI class name that creates sessions with the directory service.</td>
</tr>
<tr>
<td>URL</td>
<td>Specifies the URL used to connect to the directory service.</td>
</tr>
<tr>
<td>Principal</td>
<td>Specifies the user id to connect to the directory service.</td>
</tr>
<tr>
<td>Credentials</td>
<td>Specifies the password used to connect to the directory service.</td>
</tr>
</tbody>
</table>

#### Properties

This tab allows you to specify additional properties that are supported by the JDBC driver. Properties are defined using name/value pairs.

#### Runtime Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Pool Size</td>
<td>Specifies the maximum number of connections within the connection pool. Database connections are grouped together within a connection pool to improve performance.</td>
</tr>
<tr>
<td>Maximum connections per user</td>
<td>Specifies the maximum number of connections within the connection pool for each user.</td>
</tr>
<tr>
<td>Connection Idle Time (minutes)</td>
<td>Specifies how long a connection can be idle before it times out.</td>
</tr>
<tr>
<td>Minimum Pool Size</td>
<td>Specifies the minimum number of connections with the connection pool.</td>
</tr>
<tr>
<td>Maximum Opened Cursors</td>
<td>Specifies how many queries can be created for each connection.</td>
</tr>
</tbody>
</table>

### Configure Organization Provider - Hydrogen

This page displays configuration information used by the ALI Identity Service (Hydrogen).

#### Basic Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hydrogen Service Host</td>
<td>Specifies the host where the ALI Identity Service (Hydrogen) is deployed.</td>
</tr>
</tbody>
</table>
**Option** | **Description**
--- | ---
Hydrogen Service Port | Specifies the port where the ALI Identity Service is listening.
Service Endpoint URL | Specifies the URL of the ALI Portal Query Service.

### Runtime Tab

| Option | Description |
--- | --- |
Maximum Pool Size | Specifies the maximum number of connections within the connection pool. Database connections are grouped together within a connection pool to improve performance. |
Maximum connections per user | Specifies the maximum number of connections within the connection pool for each user. |
Connection Idle Time (minutes) | Specifies how long a connection can be idle before it times out. |
Minimum Pool Size | Specifies the minimum number of connections with the connection pool. |
Maximum Opened Cursors | Specifies how many queries can be created for each connection. |

### Configure Organization Provider - Sun LDAP

#### Basic Tab

| Options | Description |
--- | --- |
Initial Context Factory | Specifies the JNDI class name that creates sessions with the directory service. |
URL | Specifies the URL used to connect to the directory service. |
Principal | Specifies the user id to connect to the directory service. |
Credentials | Specifies the password used to connect to the directory service. |

### Properties

This tab allows you to specify additional properties that are supported by the JDBC driver. Properties are defined using name/value pairs.

#### Runtime Tab

| Option | Description |
--- | --- |
Maximum Pool Size | Specifies the maximum number of connections within the connection pool. Database connections are grouped together within a connection pool to improve performance. |
Maximum connections per user | Specifies the maximum number of connections within the connection pool for each user. |
Connection Idle Time (minutes) | Specifies how long a connection can be idle before it times out. |
Minimum Pool Size | Specifies the minimum number of connections with the connection pool. |
Maximum Opened Cursors | Specifies how many queries can be created for each connection. |

### Enter Directory Creation Information

The page allows you to enter the database administrator username and password. The Configuration Wizard uses this information to connect to the database and create run the SQL scripts to create database schema.
Note: This page does not appear if you have chosen to generate SQL scripts.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DBA User</td>
<td>Specifies the Database Administrator user id.</td>
</tr>
<tr>
<td>DBA Password</td>
<td>Specifies the Database Administrator password.</td>
</tr>
<tr>
<td>Organization Logical Name</td>
<td>Defines the organization logical name for this ALBPM environment. This symbolic name is used in contexts where processes in different environments communicate with each other.</td>
</tr>
</tbody>
</table>

Show SQL Script
The page displays the generated SQL scripts for the ALBPM directory database. This page is displayed only if you have chosen to generate a SQL script instead of having the Configuration Wizard connect to the database. The DBA of the directory service database can use the script to create the necessary tables and schema.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy to clipboard</td>
<td>Allows you to copy the generated script to the clipboard.</td>
</tr>
<tr>
<td>Save to file</td>
<td>Allows you to save the generated script to a file.</td>
</tr>
</tbody>
</table>

Process Engine Provider Selection

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Engine Database Provider</td>
<td>Specifies the database vendor of your Process Engine database.</td>
</tr>
</tbody>
</table>

Process Engine Provider - Oracle

Basic Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>Specifies either the IP address or the hostname of the database server.</td>
</tr>
<tr>
<td>Port</td>
<td>Specifies the TCP port of the listener running on the database server. The default is 1521, which is the default port number when installing the Oracle database software.</td>
</tr>
<tr>
<td>User</td>
<td>Defines the user id used to connect to the database.</td>
</tr>
<tr>
<td>Password</td>
<td>Defines the password for the user id used to connect to the database. This password is case-insensitive.</td>
</tr>
<tr>
<td>SID</td>
<td>Specifies the Oracle System Identifier that refers to the instance of the Oracle database running on the server.</td>
</tr>
<tr>
<td>Schema</td>
<td>Optionally, specifies the name of the schema used.</td>
</tr>
<tr>
<td></td>
<td>Note: When using a schema, it is recommended that the schema name and user name be the same.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Selecting the Advanced checkbox allows you to specify a specific database to connect to. This is defined in the Database field.</td>
</tr>
<tr>
<td>URL</td>
<td>Defines the URL format to connect to the database.</td>
</tr>
</tbody>
</table>

Advanced Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tablespace</td>
<td>Specifies the tablespace within the ALBPM database.</td>
</tr>
</tbody>
</table>
### Option Description

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temporary Tablespace</td>
<td>Specifies the temporary tablespace within the ALBPM database.</td>
</tr>
<tr>
<td>Profile</td>
<td>Specifies the profile for the ALBPM database. Profiles are as a way to limit which users can connect to the database.</td>
</tr>
</tbody>
</table>

### Properties

This tab allows you to specify additional properties that are supported by the JDBC driver. Properties are defined using name/value pairs.

### Runtime

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Pool Size</td>
<td>Specifies the maximum number of connections within the connection pool. Database connections are grouped together within a connection pool to improve performance.</td>
</tr>
<tr>
<td>Maximum connections per user</td>
<td>Specifies the maximum number of connections within the connection pool for each user.</td>
</tr>
<tr>
<td>Connection Idle Time (minutes)</td>
<td>Specifies how long a connection can be idle before it times out.</td>
</tr>
<tr>
<td>Minimum Pool Size</td>
<td>Specifies the minimum number of connections with the connection pool.</td>
</tr>
<tr>
<td>Maximum Opened Cursors</td>
<td>Specifies how many queries can be created for each connection.</td>
</tr>
</tbody>
</table>

### Process Engine Provider - DB2

#### Basic Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>Specifies either the IP address or the hostname of the database server. For example, 122.23.15.12 or ALBPMDatabase.</td>
</tr>
<tr>
<td>Port</td>
<td>Specifies the TCP port of the listener running on the database server. The default is 1521, which is the default port number when installing the Oracle database software.</td>
</tr>
<tr>
<td>User</td>
<td>Defines the user id used to connect to the database.</td>
</tr>
<tr>
<td>Password</td>
<td>Defines the password for the user id used to connect to the database. This password is case-insensitive.</td>
</tr>
<tr>
<td>Database</td>
<td>Defines the name of the database used for the ALBPM directory service.</td>
</tr>
<tr>
<td>URL</td>
<td>Defines the URL format to connect to the database.</td>
</tr>
</tbody>
</table>

### Properties

This tab allows you to specify additional properties that are supported by the JDBC driver. Properties are defined using name/value pairs.

### Runtime

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Pool Size</td>
<td>Specifies the maximum number of connections within the connection pool. Database connections are grouped together within a connection pool to improve performance.</td>
</tr>
<tr>
<td>Maximum connections per user</td>
<td>Specifies the maximum number of connections within the connection pool for each user.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Connection Idle Time (minutes)</td>
<td>Specifies how long a connection can be idle before it times out.</td>
</tr>
<tr>
<td>Minimum Pool Size</td>
<td>Specifies the minimum number of connections with the connection pool.</td>
</tr>
<tr>
<td>Maximum Opened Cursors</td>
<td>Specifies how many queries can be created for each connection.</td>
</tr>
</tbody>
</table>

**Process Engine Provider - SQL Server**

**Basic Tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>Specifies either the IP address or the hostname of the database server.</td>
</tr>
<tr>
<td>Port</td>
<td>Specifies the port of the listener running on the database server.</td>
</tr>
<tr>
<td>User</td>
<td>Defines the user id used to connect to the database.</td>
</tr>
<tr>
<td>Password</td>
<td>Defines the password for the user id used to connect to the database.</td>
</tr>
<tr>
<td>Database</td>
<td>Specifies the name of the database.</td>
</tr>
<tr>
<td>URL</td>
<td>Defines the URL format to connect to the database.</td>
</tr>
</tbody>
</table>

**Properties**

This tab allows you to specify additional properties that are supported by the JDBC driver. Properties are defined using name/value pairs.

**Runtime**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Pool Size</td>
<td>Specifies the maximum number of connections within the connection pool.</td>
</tr>
<tr>
<td></td>
<td>Database connections are grouped together within a connection pool to improve performance.</td>
</tr>
<tr>
<td>Maximum connections per user</td>
<td>Specifies the maximum number of connections within the connection pool for each user.</td>
</tr>
<tr>
<td>Connection Idle Time (minutes)</td>
<td>Specifies how long a connection can be idle before it times out.</td>
</tr>
<tr>
<td>Minimum Pool Size</td>
<td>Specifies the minimum number of connections with the connection pool.</td>
</tr>
<tr>
<td>Maximum Opened Cursors</td>
<td>Specifies how many queries can be created for each connection.</td>
</tr>
</tbody>
</table>

**Enter Process Engine Creation Information**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DBA User</td>
<td>Specifies the Database Administrator user id.</td>
</tr>
<tr>
<td>DBA Password</td>
<td>Specifies the Database Administrator password.</td>
</tr>
</tbody>
</table>

**Show SQL Script**

This page displays the generated SQL script which is used by your database administrator to create the necessary tables and schema.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy to clipboard</td>
<td>Allows you to copy the generated script to the clipboard.</td>
</tr>
</tbody>
</table>
Select EAR Files to Create - WebLogic Server
This page allows you to select which application EAR files you want to create and deploy within your WebLogic Server installation.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EAR Files Folder</td>
<td>Specifies the directory where the generated WAR files are saved.</td>
</tr>
<tr>
<td>Process Engine EAR</td>
<td>EAR file for the Process Execution Engine</td>
</tr>
<tr>
<td>WorkSpace EAR</td>
<td>EAR file for the WorkSpace web application (for end users)</td>
</tr>
<tr>
<td>WorkSpace Administrator EAR</td>
<td>EAR file for the WorkSpace Admin web application (for Administrators)</td>
</tr>
<tr>
<td>RSS Feeds EAR</td>
<td>EAR file for the RSS Feeds web application (for end users to subscribe to their work lists)</td>
</tr>
<tr>
<td>ALSB/ALBPM Transport EAR</td>
<td>EAR file for the optimized transport for AquaLogic Service Bus</td>
</tr>
</tbody>
</table>

Configure WebLogic Server

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create New Domain</td>
<td>Causes the configuration wizard to create a new WebLogic Server domain.</td>
</tr>
<tr>
<td>Modify an Existing Domain</td>
<td>Causes the configuration wizard to configure and deploy to an existing WebLogic Server domain.</td>
</tr>
<tr>
<td>Note: If you are using the configuration wizard to deploy to a clustered domain, you must select this option.</td>
<td></td>
</tr>
<tr>
<td>WebLogic Home</td>
<td>Specifies the WebLogic Server administrator ID.</td>
</tr>
<tr>
<td>Hostname</td>
<td>Specifies the WebLogic Server administrator password.</td>
</tr>
<tr>
<td>Port</td>
<td></td>
</tr>
<tr>
<td>Server Name</td>
<td></td>
</tr>
<tr>
<td>Domain Name</td>
<td></td>
</tr>
<tr>
<td>Domain Folder</td>
<td></td>
</tr>
</tbody>
</table>

Configuring ALBPM
This page appears while the ALBPM Configuration Wizard is running. It may take several minutes for this to complete.

ALBPM Configuration Complete
This page appears after the ALBPM Configuration Wizard is complete. Click Finish to close the configuration wizard.
Example web.xml for WebLogic Portal

When configuring AquaLogic BPM to work with WebLogic Portal you must use the following web.xml as part of your WebLogic Portal configuration.

This file can be downloaded at: http://edocs.bea.com/albsi/docs60/resources/workspace_wlp/web.xml. See WebLogic Portal Configuration on page 19 for more information.

```xml
<?xml version="1.0" encoding="UTF-8"?>
<web-app id="WebApp_ID" version="2.4" xmlns="http://java.sun.com/xml/ns/j2ee"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
  <display-name>WorkSpaceWebProject</display-name>
  <welcome-file-list>
    <welcome-file>index.html</welcome-file>
    <welcome-file>index.htm</welcome-file>
    <welcome-file>index.jsp</welcome-file>
    <welcome-file>default.html</welcome-file>
    <welcome-file>default.htm</welcome-file>
    <welcome-file>default.jsp</welcome-file>
  </welcome-file-list>
  <context-param>
    <param-name>javax.faces.STATE_SAVING_METHOD</param-name>
    <param-value>server</param-value>
  </context-param>
  <context-param>
    <param-name>com.sun.faces.validateXml</param-name>
    <param-value>true</param-value>
  </context-param>
  <context-param>
    <param-name>com.sun.faces.verifyObjects</param-name>
    <param-value>true</param-value>
  </context-param>
  <servlet>
    <servlet-name>Faces Servlet</servlet-name>
    <servlet-class>javax.faces.webapp.FacesServlet</servlet-class>
  </servlet>
  <filter>
    <filter-name>PageFlowJspFilter</filter-name>
  </filter>
  <filter>
    <filter-name>PageFlowForbiddenFilter</filter-name>
    <init-param>
      <param-name>response-code</param-name>
      <param-value>404</param-value>
    </init-param>
  </filter>
  <filter>
    <filter-name>Character Encoding</filter-name>
    <filter-class>fuego.web.filter.CharsetFilter</filter-class>
  </filter>
  <filter>
    <filter-name>SingleThreadPerSessionFilter</filter-name>
    <filter-class>fuego.web.filter.SingleThreadPerSessionFilter</filter-class>
    <init-param>
      <param-name>enabled</param-name>
      <param-value>true</param-value>
    </init-param>
  </filter>
  <filter>
    <filter-name>CacheResourcesFilter</filter-name>
    <filter-class>fuego.web.filter.CacheResourceFilter</filter-class>
    <init-param>
      <param-name>enabled</param-name>
    </init-param>
  </filter>
</web-app>
```
<param-value>true</param-value>
</init-param>
</filter>
<filter-mapping>
  <filter-name>CacheResourcesFilter</filter-name>
  <url-pattern>*.js</url-pattern>
</filter-mapping>
<filter-mapping>
  <filter-name>CacheResourcesFilter</filter-name>
  <url-pattern>*.css</url-pattern>
</filter-mapping>
<filter-mapping>
  <filter-name>CacheResourcesFilter</filter-name>
  <url-pattern>*.gif</url-pattern>
</filter-mapping>
<filter-mapping>
  <filter-name>CacheResourcesFilter</filter-name>
  <url-pattern>*.png</url-pattern>
</filter-mapping>
<filter-mapping>
  <filter-name>SingleThreadPerSessionFilter</filter-name>
  <url-pattern>*.xhtml</url-pattern>
</filter-mapping>
<filter-mapping>
  <filter-name>SingleThreadPerSessionFilter</filter-name>
  <url-pattern>/servlet/*</url-pattern>
</filter-mapping>
<filter-mapping>
  <filter-name>Character Encoding</filter-name>
  <url-pattern>/*</url-pattern>
</filter-mapping>
<filter-mapping>
  <filter-name>PageFlowJspFilter</filter-name>
  <url-pattern>*.jsp</url-pattern>
  <dispatcher>FORWARD</dispatcher>
  <dispatcher>REQUEST</dispatcher>
  <dispatcher>INCLUDE</dispatcher>
</filter-mapping>
<filter-mapping>
  <filter-name>PageFlowJspFilter</filter-name>
  <url-pattern>*.jspx</url-pattern>
  <dispatcher>FORWARD</dispatcher>
  <dispatcher>REQUEST</dispatcher>
  <dispatcher>INCLUDE</dispatcher>
</filter-mapping>
<filter-mapping>
  <filter-name>PageFlowForbiddenFilter</filter-name>
  <url-pattern>*.java</url-pattern>
  <dispatcher>REQUEST</dispatcher>
</filter-mapping>
<filter-mapping>
  <filter-name>PageFlowForbiddenFilter</filter-name>
  <url-pattern>*.jsfb</url-pattern>
  <dispatcher>REQUEST</dispatcher>
</filter-mapping>
<filter-mapping>
  <filter-name>PageFlowForbiddenFilter</filter-name>
  <url-pattern>*.jpfs</url-pattern>
  <dispatcher>REQUEST</dispatcher>
</filter-mapping>
<listener>
<listener-class>org.apache.beehive.netui.pageflow.PageFlowContextListener</listener-class>
</listener>
<listener>
<listener-class>org.apache.beehive.netui.pageflow.HttpSessionMutexListener</listener-class>
</listener>
<listener-class>fuego.workspace.execution.WorkspaceExecutionSessionListener</listener-class>
</listener>
<listener-class>fuego.workspace.context.WorkspaceContextListener</listener-class>
</listener>
<listener-class>com.sun.faces.config.ConfigureListener</listener-class>
</listener>
<servlet>
    <servlet-name>action</servlet-name>
    <servlet-class>org.apache.beehive.netui.pageflow.PageFlowActionServlet</servlet-class>
    <init-param>
        <param-name>config</param-name>
        <param-value>/_pageflow/struts-config.xml</param-value>
    </init-param>
    <init-param>
        <param-name>debug</param-name>
        <param-value>2</param-value>
    </init-param>
    <init-param>
        <param-name>detail</param-name>
        <param-value>2</param-value>
    </init-param>
    <load-on-startup>2</load-on-startup>
</servlet>
<servlet>
    <servlet-name>XmlHttpRequestServlet</servlet-name>
    <servlet-class>org.apache.beehive.netui.pageflow.xmlhttprequest.XmlHttpRequestServlet</servlet-class>
</servlet>
<!--Executor Servlet -->
<servlet>
    <servlet-name>ExecutorServlet</servlet-name>
    <servlet-class>fuego.workspace.servlet.ExecutorServlet</servlet-class>
    <load-on-startup>1</load-on-startup>
</servlet>
<!-- Image Servlet -->
<servlet>
    <servlet-name>ImageViewer</servlet-name>
    <servlet-class>fuego.workspace.servlet.ImageViewer</servlet-class>
    <load-on-startup>1</load-on-startup>
</servlet>
<!-- Instance Detail Servlet -->
<servlet>
    <servlet-name>Controller</servlet-name>
    <servlet-class>fuego.workspace.servlet.Controller</servlet-class>
    <load-on-startup>1</load-on-startup>
</servlet>
<!-- Download Attachment Servlet -->
<servlet>
    <servlet-name>DownloadAttachmentServlet</servlet-name>
    <servlet-class>fuego.workspace.servlet.DownloadAttachmentServlet</servlet-class>
    <load-on-startup>1</load-on-startup>
</servlet>
<servlet-mapping>
    <servlet-name>action</servlet-name>
    <url-pattern>*.jpf</url-pattern>
</servlet-mapping>
<servlet-mapping>
    <servlet-name>action</servlet-name>
    <url-pattern>*.do</url-pattern>
</servlet-mapping>
<servlet-mapping>
    <servlet-name>XmlHttpRequestServlet</servlet-name>
    <url-pattern>*.xhr</url-pattern>
</servlet-mapping>
<servlet-name>XmlHttpRequestServlet</servlet-name>
<url-pattern>*.render</url-pattern>
</servlet-mapping>

<!-- extension mapping -->
<servlet-mapping>
<servlet-name>ExecutorServlet</servlet-name>
<url-pattern>/servlet/executor</url-pattern>
</servlet-mapping>
<servlet-mapping>
<servlet-name>ImageViewer</servlet-name>
<url-pattern>/servlet/image</url-pattern>
</servlet-mapping>
<servlet-mapping>
<servlet-name>Controller</servlet-name>
<url-pattern>/servlet/controller</url-pattern>
</servlet-mapping>
<servlet-mapping>
<servlet-name>DownloadAttachmentServlet</servlet-name>
<url-pattern>/servlet/download</url-pattern>
</servlet-mapping>

<!-- Use Documents Saved as *.xhtml -->
<context-param>
<param-name>javax.faces.DEFAULT_SUFFIX</param-name>
<param-value>.xhtml</param-value>
</context-param>
<context-param>
<param-name>com.sun.faces.NUMBER_OF_VIEWS_IN_SESSION</param-name>
<param-value>15</param-value>
</context-param>
<context-param>
<param-name>fuego.upload.FILE_MAX_SIZE</param-name>
<param-value>10000000</param-value>
</context-param>
<context-param>
<param-name>facelets.DEVELOPMENT</param-name>
<param-value>false</param-value>
</context-param>
<context-param>
<param-name>facelets.VIEW_MAPPINGS</param-name>
<param-value>*.xhtml</param-value>
</context-param>
<context-param>
<param-name>facelets.REFRESH_PERIOD</param-name>
<param-value>1</param-value>
</context-param>
<context-param>
<param-name>facelets.LIBRARIES</param-name>
<param-value>
/Web-INF/facelets/bpmWorkspace.taglib.xml;
/Web-INF/facelets/bpmWorkspaceLibrary.taglib.xml;
/Web-INF/facelets/fuegojsf.taglib.xml;
/Web-INF/facelets/htmlib.taglib.xml;
</param-value>
</context-param>
<context-param>
<param-name>javax.faces.CONFIG_FILES</param-name>
<param-value>
/Web-INF/application.xml,/WEB-INF/navigation.xml,/WEB-INF/managed-beans.xml,/WEB-INF/components.xml
</param-value>
</context-param>
<context-param>
<param-name>com.bea.opencontrols.RESOURCE_SUFFIX</param-name>
<param-value>.resource</param-value>
</context-param>
<context-param>
<param-name>com.bea.opencontrols.WLP</param-name>
<param-value>true</param-value>
</context-param>
Audit Events Overview

When Audit Events are Generated

You can define which process activities will generate auditing events.
You set whether an activity generates events in design time, and you can set this for each activity, for activity groups, or for the whole process. You can also set whether the process engine generates events or not at run time.

**Design Time**

Design time event generation options are set in Studio. At design time, the following options are available for each activity:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default (default setting)</td>
<td>Indicates that the activity will record events according to the group or process default, as described below.</td>
</tr>
<tr>
<td>Generate Events</td>
<td>The activity will generate events, regardless of the group or process default.</td>
</tr>
<tr>
<td>Do not Generate Events</td>
<td>The activity will not generate events, regardless of the process default.</td>
</tr>
</tbody>
</table>

Also at design time, the following options are available for each group:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default (default setting)</td>
<td>Indicates that the group's activities will record events according to the process setting, as described below.</td>
</tr>
<tr>
<td>Generate Events</td>
<td>The default for the group's activities will be to generate events, regardless of the process default.</td>
</tr>
<tr>
<td>Do not Generate Events</td>
<td>The default for the group's activities will be not to generate events, regardless of the process default.</td>
</tr>
</tbody>
</table>

The following options are available for each process. These settings will be used by activities or groups set to Default. If a group or activity is not set to Default, it will ignore the process setting.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate Events for Interactive Activities (default setting)</td>
<td>Each activity set to the Default option will generate events if it is interactive, and will not generate events if it is automatic.</td>
</tr>
<tr>
<td>Generate Events for all Activities</td>
<td>Each activity or group set to Default will generate events.</td>
</tr>
<tr>
<td>Do not Generate Events</td>
<td>Each activity or group set to Default will not generate events.</td>
</tr>
</tbody>
</table>

**Run Time**

You set run time event generation in Process Administrator, for each process engine. You can set each process engine to one of the following event recording modes:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Depends on Process (default setting)</td>
<td>Indicates that the process engine will follow the settings of each process. That is, it will follow the design time settings as described in the section above.</td>
</tr>
<tr>
<td>Never</td>
<td>No events are recorded, except instance begin and end activities. Design time settings are ignored.</td>
</tr>
<tr>
<td>Always</td>
<td>All activities generate events, regardless of process, group, or activity settings. Design time settings are ignored.</td>
</tr>
</tbody>
</table>

**Remarks**

If all settings are left at their defaults, a process will generate events for interactive activities and not for automatic activities. Begin and End activities are always generated.
This is a reasonable default because activities that require human interaction have the most variable execution times. However, you may want to measure some automatic activities, for example those that invoke external systems that for whatever reason have variable execution times.

Each event generated has a slight performance cost. This cost is not important for interactive activities since these activities spend most of their time waiting for participants to execute them. However, it may have significant impact on automatic activities that are performed frequently.

**Which Audit Events are Generated**

The following auditing events are generated:

- All the activities generate the same events (IN, OUT, EXECUTE, SELECT, UNSELECT, among others.)
- The Begin activity has no Activity IN event as the instance is created in it.
- The End activity has no Activity OUT event as the instance terminates there.
- The Join activity generates events only if the Split associated activity generates events.
- When an instance is created, a CREATION event is generated instead of an Enter event. This event is always automatically generated if the Engine stores events. All original instances (copy 0) have the CREATION event.
- When an instance is finished, an END event is generated. This event is always automatically generated if the Engine stores events. All terminated original instances (copy 0) have the END event.
- Interactive activities have additional events that occur between the Enter and End events.

If you have any Generates events check box selected, the Audit Trail in WorkSpace is enabled. The Audit Trail displays all events that have occurred for an instance.